Opening another person's mailbox

SPEAKER NOTES: Clarify that this is not a common activity for most users, except for sharing calendars. Calendar sharing is very common among end users, but mailbox sharing typically only occurs when you have a delegate. Point out that, while the process is similar in Outlook, the OWA process to share calendars is slightly different, driven mostly by interface limitations in the browser.

If you have been granted access to another user's mailbox, you can open it from OWA. This is most common for people sharing calendar details with their team mates, but could apply to any folder in the mailbox. To open another user's mailbox, right-click your mailbox top level folder (named "Anthony Witecki" in the diagram) and choose **Open Other User's Inbox**. You'll be asked to provide the name of the user and, if you have permission, that user's inbox will be opened and viewable.

![Opening another Inbox](image)

For most users, calendar sharing is more common than mailbox sharing. You might share your calendar details with team mates so that they can see specific appointments and meetings you're attending, as opposed to just the free-busy time which only shows vague availability information.

**Opening another's calendar**

1. Switch to the calendar view in OWA
2. Right-click **People's Calendars**
3. Select **Add Calendar** from the context menu
4. Enter the name of the person whose calendar you wish to view. If you have permissions, that person's calendar will be displayed side-by-side with your own.

Once the calendar is added, it is retained in a list on the tree pane and you can simply check the boxes for any of your previously added colleagues. You can display several calendars at once, provided your monitor supports it and you're willing to forgo details as the number of simultaneously displayed calendars increases. This feature is generally not used for purposes of scheduling meetings. It is
intended to allow colleagues view details, when appropriate, to help them better communicate and minimize disruption.

**Sharing your calendar details with others**

You can also set permissions for others who want to view your calendar.

**To share your calendar:**

1. From the calendar view, click the Share button
2. Choose *Share This Calendar* from the drop down menu. OWA will open a new message that you can send to the recipients with whom you'd like to share your calendar.
3. Enter the email address of the recipient
4. Select the *All information* radio button
5. Enter any comments for the recipient in the freeform text area at the bottom
6. Click Send
If you want the recipient to see all calendar details, you should select the All Information radio button. You can also check the box "I want to request permission to view the recipients Calendar folder." The recipient will get to decide whether to accept or decline and you'll receive a response that looks similar to the following:

To complete the process, you'll need to click Add This Calendar located in the body of the reply message. This adds the recipient your list of People's calendars.
If you want to remove or change permissions, you can select **Change Sharing Permissions** from the **Share** menu. The permissions granted on your calendar will display in the **Client Permissions** dialog box. You'll be able to remove users you currently share with or edit existing permissions for users, limited of course to:

- Free Busy Only
- Free Busy with Subject and Location Information
- All Information (Subject and body of calendar items)

Once you make the changes, you can close the dialog box (no need to hit save, changes are dynamically made).

**Sending as or on behalf of someone else**

*SPEAKER NOTES: there are a few key points you need to focus on when delivering this section:*

1. There is a process for gaining these rights. End users cannot grant them.
2. Differentiate "send as" from "send on behalf" and make sure students understand how email is perceived by recipients in each scenario. Also mention that they are always mutually exclusive permissions (if you have send as, it will always send as).
3. Mention that the FROM field is always implied but typically not shown. By receiving either right, you can change who the mail is from. The rights only dictate what the recipient sees.
This configuration is common among people who delegate management of their inbox to others. In most cases, this may not apply to you. Many people confuse the ability to send as another person with the ability to send on their behalf. When you send as someone, you have essentially been entrusted to speak for that person. Mail messages that you initiate or reply to will appear to come from the person you’re sending as. Recipients have no way of knowing that you are replying on someone else’s behalf.

When you send on behalf of someone else, you’ve been granted to right to reply to messages or create messages that appear to originate from that sender when the message arrives (notifications) and while viewing the item in list view. However, when recipients open the message, they will be able to see that you are acting on behalf of someone else by looking at the from field.

Typically, only one or the other permission is granted on a mailbox to an individual. You must create a service request to grant someone either send as or send on behalf permission to your mailbox or to be granted either send as or send on behalf access to someone else’s. You cannot establish send-as or send-on-behalf permissions yourself.

![Image showing settings for from and Bcc fields]

Figure 6 - Setting from and Bcc fields by default

Once the permission has been granted, however, sending as or on behalf is as simple as changing the from field on a message. By default, the from field is not visible in OWA. To make it visible, go to Options -> Settings -> Mail -> Message format and check the option box titled "Always Show From." Once the from field is made visible, you’ll be able to substitute your name for the name you want the mail to appear to come from. Depending on the permissions granted, your message will either be sent as the other person or will appear to be sent on behalf of that person.

---

1 If you want, you can also enable the Bcc field to always be visible by checking "Always Show Bcc."
Calendar Basics in OWA

SPEAKER NOTES: This demonstration will walk students through the basic capabilities of the OWA calendar functionality. The focus of this demo is to show the four different views in OWA and the "Go to Today" button, as well as printing your schedule. Key points:

4. The day view typically displays the most detail about individual calendar items. As you increase the time interval, fewer details for each appointment are visible.

5. Point out that OWA shades your stated work hours differently from non-working hours. If someone tries to schedule a meeting outside of working hours, they will receive notice of that fact. It doesn't prevent them from sending the meeting request, but instead uses the technology to optimize when you're most likely to respond. Setting working hours will be discussed in a subsequent lesson.

6. Printing in OWA is handled by its own wizard. This was developed to override some of the default printing limitations in web browsers. By using the wizard, you can always ensure that the schedule takes the format and level of details appropriate for your situation.

This chapter covers the basics associated with viewing your calendar, printing your schedule, and scheduling appointments, meetings and recurring meetings with others.

Viewing your calendar

Outlook Web App’s calendar functionality works very similar to the full Outlook client. Reminders set on appointments will pop up in the OWA interface, so long as you are logged on. You also have several different views of your calendar available. You can select the view most relevant to you by choosing the appropriate button from the calendar page toolbar.
To view only one day at a time, click the **Day** view button.

If your calendar is on a different day and you want to see today's calendar, click the **Go to Today** button.

To view the work week, click the **Work Week** view button. This will display a five day view. By default, Saturday and Sunday will not be displayed.

The full week (7 day) view shows appointments on Saturday and Sunday as well.

The month view gives you a month-at-a-glance view of your calendar. Individual appointment items are displayed and stacked within the box on the day they are scheduled, but no detailed information is generally available.

The **Reading Pane** displays specific information about a meeting on your calendar. This option is available for all views except **Month** view. You can also double-click the individual appointments to see their details.

*To turn the reading pane on or off:*

When the Reading Pane is on, information about the meeting is displayed.

1. Click the **View** drop-down list
2. Click the **Right** list item to turn the reading pane on, Click the **Off** list item to turn the reading pane off.
Printing your itinerary

When you change your view from mail (inbox) to calendar, the toolbars at the top of the page change to reflect common tasks associated with scheduling and calendars. On the right side of the calendar toolbar is a printer button, which is actually a calendar printing wizard.

Figure 8 - Print button in calendar view

No matter which calendar view is currently open, clicking the Print this calendar button will open the calendar print wizard. The print window will pop up, allowing you to choose the Day, Week or Month views, each of which uses a format optimized to balance calendar details against the time interval.

Figure 9 - Print calendar wizard

With the Day View option you have the following additional print options to select from:

- **Print from**: a time range, which defaults to your pre-set default working hours.
- **Print detailed agenda along with calendar** - This provides the graphical calendar view as well as any notes, agendas, or other information in the body of each calendar item.
- **Print narrower calendar to leave room for notes** - as it implies, this prints the same information, but shrinks the page output size to allow room for notes.
The last step is to click **Print**. This will open the **Print** dialog box where you select your printer and preferences.

**Creating an appointment or meeting**

SPEAKER NOTES: In this lesson, you’ll show users how to create a new appointment (or new meeting) and, most importantly, how to convert an appointment to a meeting. To begin, demonstrate the **New Item** menu from the calendar view in OWA and describe the difference between an appointment and a meeting. Demonstrate the process of creating a meeting by:

1. Click the **New** button and choose **Appointment**.
2. Fill out the details for the appointment: subject, location, start and end times.
3. Call out the **Reminder** and **Show Time As** attributes. Provide some general guidelines around their use, such as:
   a. Reminders should provide ample time for travel, when applicable.
   b. Show time as should reflect how you want others to perceive your availability. Point out the difference between Busy, Tentative and Out of Office and how they might be interpreted by others viewing your free-busy information. May even want to discuss anecdotes about people who intentionally block out their calendars (and whether that’s a good idea or not)
4. Save and close the appointment. Your dialog might now change to sometime like, "Suppose now you want to convert this to a meeting, instead of an appointment. How do you do this? Simple; invite others."
   a. Open the appointment object and click on the **Invite Others** icon (calendar icon with little mailbox on it).
   b. Type in some people you’d like to send the invitation to.
   c. Show how the resolve button on the toolbar can be used to resolve email addresses from the global address list using ambiguous name resolution. Also point out that **ALT+K** will perform the same function, just like in Outlook.
   d. Demonstrate the Scheduling tab's display of free-busy information. You may also have to point out that free-busy is not available until users' names are resolved. While OWA will attempt to do this automatically, it is sometimes a manual process.
5. The final part of this lesson is discussing recurring meetings. You’ll need to walk through the specific information about how recurrence works, how it handles exceptions and why recurring meetings are such a problem in the first place. Be sure to emphasize the following points:
   a. **ALWAYS** put end dates on recurring meetings. Recurring meetings without end dates cause issues both logistically (such as when people leave the org) and technically (many third party solutions, like Blackberry, have historically had trouble interpreting never-ending recurring meetings.
   b. **Change the series whenever possible, versus individual instances.** Once an instance diverges from the series, it will not be auto-updated if the series is.

What is the difference between an Appointment and a Meeting? You create an Appointment for a Calendar item that involves only you. You create a Meeting for a Calendar item that involves you and other people. An appointment is just like a meeting, except you do not invite attendees. You can add
appointments to your calendar to schedule work duties, events, or reminders. You can also convert any appointment to a meeting by clicking the Invite Attendees button on the appointment's toolbar.

**Creating an appointment or meeting request in OWA**
1. Click the **New** button from the OWA calendar toolbar
2. Select **Appointment** or **Meeting Request**.

From there, a new window will open where you can enter appointment or meeting details.

![Microsoft Outlook Web App](image)

**Figure 10 - Creating a new appointment**

3. In the **Subject** field type in the title of the appointment. If this is a meeting request, try to be descriptive enough so that the recipients understand the meeting’s purpose at a glance.
4. Next, type in the location at the **Location** field. The location should correspond to a building name and room number if on campus or a physical address otherwise. When using a physical address, separate the street, city, and state with commas. By having a single line address, users can quickly copy and paste the location into a search engine or mapping tool.
5. Select the appropriate **date** and **time**.
   a. Click the arrows to the right of the date boxes to pull up a calendar.
   b. Select a date. Click the arrows on the right of the time boxes for a dropdown menu of times to choose from. If you are connecting to OWA from another time zone, be sure to validate that your meeting is occurring in the right time zone.
6. If you wish your reminder time to be something other than the default (15 minutes), click the drop down arrow on the right of the **Reminder** box to choose what time increment you want for your reminder pop-ups. You can uncheck the **Reminder** box if you wish to not receive any reminders.

**NOTE:** If you’re inviting guests to your meeting, consider their needs as well. If 30 minutes of travel time is necessary, perhaps a 45 minute reminder is more appropriate than 15.

7. In the **Show time as:** list, select how you want your schedule to appear for the duration of the appointment. Your selection (**Busy**, **Free**, **Tentative**, or **Out of Office**) is what others will see when they view your schedule. If you meeting is simply a reminder (this is particularly
common with all day events), be sure to set the **Show time as** to **free**. This provides you with the reminder you need without blocking out your calendar to others whom might want to meet with you.

8. If you want to prevent other people from viewing the details of the appointment, check the **Private** box. This is common for doctor appointments, etc. Other people in your organization will see that you’re not available, but, even for those who have full calendar access, they will only see that you have a private appointment.

9. In the text field below, type any additional information related to the appointment. It is best practice to use this space to clearly lay out the meeting’s agenda.

10. Click the **Save and Close** link in the upper left corner.

11. If you’re sending the appointment to others, click **Send**.

![Figure 11 - Creating an appointment](image)

**Editing and canceling a meeting**

*Speaker Notes: draw attention to the flowchart that describes what happens when a user edits an appointment or a meeting versus a series or an instance within the series.*
OWA and Microsoft Outlook behave identically regarding how changes to meetings are processed. If you make changes to an appointment, and save the appointment, those changes will be reflected on your calendar. If you changed the start time or duration of an appointment, OWA will automatically adjust the location of the appointment on your calendar. If you change a meeting, both clients will recognize that updates should be sent out to recipients after being updated on the organizer's calendar.

When you need to cancel a meeting or appointment, you can delete the appointment from either the calendar view or by clicking the "X" button in the opened item. If the item is an appointment, you'll be asked to confirm your decision to delete it and if you do, it will be removed from your calendar. If you...
delete a meeting request, you'll be asked whether you want to send out a cancellation request. There are a few things you'll want to consider when deleting meetings:

- If you want to remove the meeting request from your calendar, but keep the meeting on the other participants' calendars, choose No (do not send out a cancellation notice). Typically this is done when the organizer has to delegate the meeting chair responsibilities to someone else because of schedule conflicts.
- If you want to cancel the meeting for all involved, choose Yes (send the cancellation notice).
- If you are working with a series, pay attention to whether you're cancelling a single instance or the whole series.

**Scheduling and changing a recurring meeting**

*Speaker Notes: Transition to the challenges presented by recurring meetings. Point out that Outlook, OWA and Exchange almost always follow the flowchart above. But recurring meetings are a challenging logistical problem and most incidents involving recurring meetings are resolved as user error. By understanding the logic followed by the computer, however, fewer of these problems can generally be expected.*

A recurring meeting is one that happens with a consistent frequency: 10:00 every Monday, 2:30 PM on the first Tuesday of each month, etc. Outlook and OWA allow you to create recurring appointments and meetings. Each recurring meeting that you create actually creates multiple objects in the system. A series collection is created that represents the standard appointment. Each instance in the series, however, is also its own separate object. This is done to facilitate schedule changes that require, for example, next week's meeting to be held at 2:00 instead of 1:00, but the *standard meeting time (series)* remains at 1:00.

Scheduling and recurring meetings were actually quite complex before technology entered the picture (and when we all had considerably fewer meetings). Consider the following scenario:

Alice schedules a project meeting with Bob to occur every Monday at 9:00 AM. The series is scheduled to end with the project, after 26 weeks. By Friday, Alice realizes Week 2’s meeting must be changed to 3:00 PM. She opens the instance and changes the start time to 3:00 PM. This only changes one instance. The other 24 instances will still occur at 9:00 AM. On Friday of Week 10, Alice's new boss schedules a recurring 9:00 Monday meeting with her. Starting on week 11, she needs to update the entire series to Monday at 1:00 PM. In this case, she'll open the series and make the change. All individual instances will be moved to the new time, except the Week 2 meeting, which will stay at 3:00.

Week 2’s meeting was an exception to the series. When the series is changed, any existing exceptions are left alone. This behavior is by-design in Exchange, Outlook and OWA, but can often confuse end users. For this reason, Microsoft provides the following guidance for all users to follow when creating recurring meeting requests.

- Always put an end-date or limit the number of occurrences for the series. No meetings go on forever. Best practice is to set up recurring meetings according to the calendar year or the school year. Example: this meeting will happen every Friday at 11:00 AM from August 1, 2012 to July 31, 2013.
If you find yourself changing the meeting time every week because of schedule conflicts, it might be necessary to open and change the entire series. The sooner you recognize and act on this, the better.

After making a change to the series, look forward a few months to ensure that all instances of the meeting are scheduled for the right time. You may need to do some cleanup if an exception already exists and wasn't updated with the series.

This allows you, as the meeting or appointment owner, to distinguish between changing an individual meeting ("I need to change next Monday's meeting to 11:00") and the entire series ("10:00 is no longer working for the group, the regular meeting time is changing to 1:00 PM"). The rules that OWA, Outlook, and Exchange apply to recurring meeting series, individual instances, and changes are complicated. But they still follow the same basic principles as depicted in Figure 12. *In most cases, it is imperative that you, as the meeting/appointment organizer, validate that your intentions are reflected in your calendar.*

**What happens when I accept meetings?**

*Speaker Notes: Accepting or tentatively accepting meetings can be as much about culture and etiquette as technology. It might be helpful to use this lesson to describe scenarios where you want to accept a meeting, but choose not to let the organizer know.*

When you accept a meeting or a recurring meeting, you are given the choice to respond with **Accept**, **Tentative**, or **Decline**. By default, every meeting request that you receive will show up as **Tentative** on your calendar. This happens on the server side and is by-design to accommodate a few common calendaring scenarios:

1. **Delegates.** Early versions of Exchange and Outlook had problems when mailbox owners and their delegates would process meeting requests at the same time. In many cases, these sync errors resulted in missed appointments or showing up to the wrong appointment.
2. **Inbox rules** can be very useful for redirecting messages sent by several members of a large distribution list (DL). However, occasionally meeting requests are sent to those DLs and the rules process these requests as mail messages. That occasionally resulted in people missing meetings because they didn't look in the folder containing the meeting request until after the meeting was over.

By setting all meeting requests to tentative upon receipt, this ensures that any reminders associated with the meeting will fire. It also allows users viewing their daily calendar to see appointments they were invited to, but not explicitly named (typically, they're part of a group that was invited as a group).

When you respond to a meeting request, you have three options: **Send Response Now**, **Edit Response Before Sending**, or **Do Not Send a Response**. Each organization has differing cultural rules about what type of response is appropriate. If you were named on the original meeting request (either explicitly or as a member of a distribution list), and the organizer updates the meeting, you will receive an update regardless of how you responded to the original meeting request. However, if you received the meeting request from someone other than the organizer (this typically happens because someone has forwarded the meeting request to you), you should always send a response. If you do not send a response, and the
organizer changes the meeting, you will not receive an updated (unless the update is forwarded to you as well).

**Automatic Calendar Processing**

<table>
<thead>
<tr>
<th>Check this...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically place new meeting requests on my calendar, marked Tentative</td>
<td>Select this to automatically add new meetings to your calendar and mark them as tentative. Selecting this option doesn’t send a reply to the meeting organizer. You must still manually accept or delete the request.</td>
</tr>
<tr>
<td>Delete meeting requests and responses that have been updated</td>
<td>Select this check box to automatically remove out-of-date meeting requests and responses from your Inbox. An out-of-date meeting request is one for which the proposed meeting time has already passed.</td>
</tr>
<tr>
<td>Automatically process requests and responses from external senders</td>
<td>By default, meeting requests and responses from people who aren't in the UA global address book aren't applied to your calendar. You should check this if most of your appointments are scheduled by external customers, vendors or other contacts not at UA.</td>
</tr>
<tr>
<td>Delete notifications about forwarded meetings</td>
<td>Select this check box to automatically put meeting forward notifications in the Deleted Items folder. By default, you'll receive these notifications when a meeting you organize is forwarded to a new recipient by one of the meeting attendees. Selecting this option doesn’t affect the actual processing of meeting request responses. If your meetings are generally extended to wider audiences beyond the original recipients, you may not feel the need for these notifications to hit your inbox.</td>
</tr>
</tbody>
</table>

**Figure 13 - Options for automated calendar processing**

Automatic calendar processing controls how meeting requests, responses, and notifications are handled. These settings do not prevent your interaction with your calendar. They are merely default behaviors intended to streamline the calendar management process. You have four options that can be turned on (checked) or off.

---

2 By default, when someone other than the meeting organizer forwards a meeting request to a new recipient, the Exchange Server on the backend detects this and sends an informational message to the organizer stating that their meeting request has been forwarded.
Managing Contacts in OWA

Speaker Notes: Contacts in OWA are pretty straightforward. You can look at them, you can add, edit and delete them, and you can make them members of a personal distribution group.

You can access your contact list in OWA by clicking on the contact view icon in the lower left corner of the OWA screen. Compared to email messages and calendars, the contacts interface in OWA is perhaps the most divergent from the full Outlook client. By default, contacts are sorted by name, with only a few sort order options to choose from. For each sort order, you can select ascending or descending.

Generally speaking, contacts are used more to store data than to work with it. Most message and calendaring functions can be handled simply by typing the recipient's name and using ambiguous name resolution to look up the actual email address. For that reason, OWA's contact interface is primarily designed as a secondary client (meaning not intended for everyday use). For that reason, OWA is missing several features/functions that are integrated into the full Outlook client.

- Contact import/export - the ability to import contacts from a file or export them to a file is not supported in OWA. Individual contacts can be created, edited and deleted, as described below.
- Change the view among phone list, business card view, and category grouping.
- Contact Quick Add - Outlook allows a grid view for adding users, tabbing from one attribute to the next.
- Integrated mail merge - the full Outlook client, coupled with Microsoft Word, allows you to initiate a mail merge document

Adding a new contact
Contacts can be added by clicking the New button on the contact toolbar. If you click the down-arrow on the right side of the button, you will receive a dropdown list of objects to create:

- New Contact - Brings up a form to create a new contact.
- New Group - Brings up a form to create a personal distribution group.
- New Message - Opens a blank mail message form.

There is no minimum information set required to create a contact. A contact can be just a single phone number, just a name, just an email address, etc. But at least one field must be filled out. How you fill out each field is a personal matter, as contacts are not shared outside of your mailbox (unless you grant others permission). When creating new contacts, pay attention to the File As field. This field is not consistent across all contacts. This is by design.

Consider a situation where your contact lists consists of both individuals and businesses. You might want "John Smith" to appear in your phonebook view as "Smith, John." However, you don't want "R-K Plumbing & Remodeling" to show up as "Remodeling, R-K Plumbing and." To accommodate this scenario, OWA and Outlook allow you to select how each contact should be filed. Over time, however, and without proper diligence paid, contact lists can become messy with some contacts listed as "First Last" and others as "Last, First."

**Adding a new personal distribution group**

As mentioned above, personal distribution groups (sometimes known as distribution lists) can be used to send mail to multiple recipients at once. Although it works the same as a global distribution group, personal distribution groups do not show up in the Global Address List and cannot be used by other users. They are typically used for aggregating external contacts. When you add a new group, you must give it a name and populate it with at least one member.

![Adding users to a personal distribution group](image)

*Figure 16 - Adding users to a personal distribution group*
Members can be added two ways: (1) type the email address (or type their name and use ambiguous name resolution) and click Add to Group or (2) click on the Members button to bring up the search dialog box.

The quickest way to populate the distribution group is to type membership information directly. If you type members from your contact list, OWA will automatically complete the contact. Once you see the contact you're seeking, you can click their name or press the [Tab] button to auto-complete the entry. The search dialog box allows you to search for your contacts using either the global address list or your contacts folders.

![Address Book Name Picker](image)

You will need to choose which location to search first. Then, enter the user's first name, last name, or part of their email address and click enter (or press the search icon). The results for that folder will be displayed below the search bar and as you click on each contact, the details will be automatically displayed in the reading pane to the right.

In order to add the contact to your personal distribution group, you must double-click on their name in the search results. This will add them to the member selections. When you click OK, the users will all be added to the personal distribution list. You can add multiple people to your list without having to press OK between each one. You can also conduct multiple searches. Each member in the Member Selections attribute will be separated by a semi-colon. You can even type addresses directly into the Members field.
Searching Contacts

Searching for contacts is built into OWA and located at the top of the list-view pane. To find a contact, simply enter any part of their name or email address into the search bar and click the search button (or hit enter). OWA provides the limited ability to filter your search results by category if you use categories to organize your contacts. The results are displayed directly below the search bar. Upon right-clicking any of the contacts in the results, OWA will bring up its own context menu, from which you can open the contact for editing, send them a new message, send a meeting request, initiate a chat session with them, or forward their contact information (as an Outlook contact object) to another recipient. You can also delete the contact or remove the contact from your default IM contact list.

Note that the OWA context menu, when activated, overrides the default browser right-click context menu. When you see the OWA context menu, it will be consistent across all browsers.
Chatting in OWA

Outlook Web App is fully integrated with both Exchange Server 2010 and Lync Server. As such, anytime you are logged onto OWA, your presence information is published to the Lync server and you can see the presence of those in your organization and on your buddy lists. You can even manage your buddy lists right from within OWA.

Your Lync contacts are listed just below the mailbox folders on the left pane of the OWA interface. You can have as many contacts or groups as you need. To add a contact, right click the group you want to add them to and select New --> New Contact from the context menu (see #1 in Figure 20). Outlook will open the address book name picker (see Figure 17 on page 18) where you can search for contacts or enter them directly. Once the user is added, right-click their name and choose Chat from the context menu (see #2 in Figure 20). This will open a separate window and you can begin chatting (#3).

As stated above, anytime you're logged into OWA, your status is communicated to those team mates who follow you. They can communicate with you using either the full Lync client or OWA (or a mobile device if enabled for such). If you're logged into OWA when they attempt to communicate with you, a new window like #3 in Figure 20 will pop up and you'll near a notification sound. Once you log out of OWA, you will receive the following message:

```
This conversation is no longer active and its contents haven't been saved. Please copy them if you need to keep them.
```

And the person you were talking to will see your status change to offline.
**Settings and Preferences in OWA**

*Speaker Notes: This section deals with the basic settings that users will need to know in order to use OWA*

![Options in OWA](image)

**Setting Time Zone**

When you logon to OWA for the first time, you're asked to select your time zone. You can change your time zone at any point, but it is recommended that you only change the OWA time zone if you're being relocated permanently or indefinitely.

When traveling, many people will set their computer clocks to the local time zone. This may cause issues for some people if they subsequently logon to OWA, which will still be configured with the default time zone. It's best to be aware of this ahead of time and understand that appointments created in OWA will be scheduled according to OWA's time zone, not the desktop's time zone.

To change your OWA time zone:

1. Choose **Options --> See All Options...** from the right side of the OWA menu bar
2. Click on the **Settings** pane (located on the left side of the screen)
3. Click on the **Regional** tab
4. Select the appropriate time zone from the **Current Time Zone** drop down box.
5. Click **Save**.

**Configuring Junk Mail Preferences**

![Block or Allow](image)
You can configure spam control in OWA using the **Block or Allow** tab of the **Block or Allow** pane in OWA’s options menu. Junk mail settings that you set in OWA are server side, meaning that they will carry forward and be applied whether you connect by OWA or Outlook. Outlook has some additional spam controls and will often catch items missed by OWA.

Every mailbox has a folder called Junk E-mail into which all items believed to be spam are moved. You can check this filter from OWA or Outlook and should occasionally do so as sometimes valid mail is marked as spam. In most cases, you can manage your spam settings without ever going into the options screen. For example:

1. If you receive mail that should be treated as junk mail, right click the message and choose **Junk E-mail --> Add Sender to Blocked Senders List** from the context menu.
2. If your messages from valid users are ending up in the junk email folder, you can right click the message and choose **Junk E-mail --> Add Sender to Safe Senders List** from the context menu.

Sometimes you’re doing business with a new organization entirely and want to ensure that mail from anyone in that organization is marked safe. By selecting **Add Sender's Domain to Safe Senders List** in #2 above, you can ensure that any user from that organization will be able to reach you.

The junk mail preferences in OWA really accomplish two goals. The first is to allow you to make changes to the lists you’ve accumulated of blocked or safe senders. The second is to control external mail flow to your inbox. At the top of the page are two radio buttons that essentially act as on and off switches for spam filtering:

- **Don’t move e-mail to my Junk E-Mail folder** - this turns off spam filtering at the client level. Messages marked as spam by the backend servers will be delivered to your inbox.³
- **Automatically filter junk e-mail** - this turns on spam filtering. Any messages marked as spam will be moved to your Junk E-Mail folder.

Directly below the on/off switch is a list of safe senders. Any email address appearing in this list will automatically be delivered to your inbox. You can add new addresses to this list by typing the full email address and clicking the **plus [+]** button. If you need to change an address, select it from the list and choose the **[Edit]** button. Enter your changes and hit **enter**. To remove an address from the list, select it and click the **[- Remove]** button.

---
³ Spam filtering in Microsoft’s Exchange Server uses a scoring system, known as spam confidence level (SCL). Messages with a high SCL are never allowed into the system; they are deleted at the university firewall. Items with lower SCLs are routed through the system and then handled according to the individual users’ preferences.
Junk E-Mail Settings
- Don’t move e-mail to my Junk E-Mail folder
- Automatically filter junk e-mail

**Safe Senders and Recipients**
Don’t move e-mail from these senders or domains to my Junk E-Mail folder.

<table>
<thead>
<tr>
<th>Enter a sender or domain here</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:alphapig@tmo.blackberry.net">alphapig@tmo.blackberry.net</a></td>
</tr>
<tr>
<td><a href="mailto:amy.hurt@state.ca.gov">amy.hurt@state.ca.gov</a></td>
</tr>
<tr>
<td><a href="mailto:andrew.hutchison@nwcsupport.com">andrew.hutchison@nwcsupport.com</a></td>
</tr>
<tr>
<td><a href="mailto:anthonyw@yahoo.com">anthonyw@yahoo.com</a></td>
</tr>
<tr>
<td><a href="mailto:anthony.huynh@lapd.lacity.org">anthony.huynh@lapd.lacity.org</a></td>
</tr>
<tr>
<td><a href="mailto:anthonyw@dis.wa.gov">anthonyw@dis.wa.gov</a></td>
</tr>
</tbody>
</table>

- Trust e-mail from my contacts

**Blocked Senders**
Move e-mail from these senders or domains to my Junk E-Mail folder.

<table>
<thead>
<tr>
<th>Enter a sender or domain here</th>
</tr>
</thead>
<tbody>
<tr>
<td>0_52711_659038c5-2837-d011-867b-0000f84aee6_us@newsletters....</td>
</tr>
<tr>
<td>0_52713_659038c5-2837-d011-867b-0000f84aee6_us@newsletters....</td>
</tr>
<tr>
<td>0_53186_659038c5-2837-d011-867b-0000f84aee6_us@newsletters....</td>
</tr>
<tr>
<td>0_53342_659038c5-2837-d011-867b-0000f84aee6_us@newsletters....</td>
</tr>
<tr>
<td><a href="mailto:10.14443.5ow7upcnf5efwojgdidqug@newsletters.microsoft.com">10.14443.5ow7upcnf5efwojgdidqug@newsletters.microsoft.com</a></td>
</tr>
<tr>
<td><a href="mailto:10.14448.2srnflpm9sp9rh4d1zcg@newsletters.microsoft.com">10.14448.2srnflpm9sp9rh4d1zcg@newsletters.microsoft.com</a></td>
</tr>
</tbody>
</table>

- Don’t trust e-mail unless it comes from someone in my Safe Senders and Recipients list or local senders

Figure 22 - Junk mail configuration screen

Under the safe senders list is a small check box called **Trust e-mail from my contacts**. By selecting this, you will ensure that any email address in your contact list is automatically accepted. By creating contacts immediately upon establishing new relationships, you can ensure any email received by them won't be routed to the junk folder.

The **Blocked Senders** list contains every email address you've explicitly blocked. You can add to, edit or removed from this list in the same way you manage the **Safe Senders** list.
Configuring automated replies (Out of Office)

Automatic replies, also known as out of office replies, are used to tell others when you are unavailable or out of the office for a specific period of time, such as vacations. The automatic reply feature allows separate auto-replies to be sent to senders both inside the organization and outside. You can choose to send all users the same automated reply, or have different replies for external contacts (such as customers, students, etc.). You can also set up automated replies to only trigger between two distinct dates, so you don’t have to remember to set your auto-replies as the last thing before leaving the office prior to leaving for vacation. Setting up your automated replies is easy:

1. From the main Mailbox list view, click on Options in the upper right hand corner.
2. Select Set Automatic Replies...

This will take you to the Organize E-Mail option and the Automatic Replies tab.

Note: another way to get to the same location is at the Account option which takes you to the My Account tab. Under Shortcuts to other things you can do click on the Tell people you're on vacation link.

From the Automatic Replies tab:

3. Back at the Automatic Replies tab select the Send automatic replies option.
4. Next, select the check box Send replies only during this time period option. If you want your automatic replies to be sent indefinitely, you may clear this checkbox.
5. The **Start time** and **End time** are set to an automatic default date (today's current date). To make changes to the date and time, select the appropriate drop. The date field uses the standard calendar style dropdown and the time field allows 30 minute increments in a standard dropdown.

6. Below the date and time dropdowns is a rich-text editor titled "**Send a reply once to each sender inside my organization with the following message.**" You may edit the contents of your INTERNAL message, including some formatting like font, color, and size. A few paragraph formatting options are also available and buttons exist to insert hyperlinks, should you need to refer people to a web site in your absence.

**NOTE:** Many people choose to NOT send automated replies to people outside their organization for security reasons. OWA will limit your automated replies to internal users, or provide selective options for automated responses to external users.

7. If you want to send automated messages outside the organization, you must check the checkbox titled "**Send automatic reply messages to senders outside my organization.**" This gives you two options. Choose one:
   a. Send replies only to senders in my Contacts list. This ensures that only people you know and have stored in your contact list will receive external replies.
   b. Send replies to all external senders. This sends replies to all users, even those you don't know. It is possible that these replies would be sent to spammers if their messages were to hit the inbox (not get filtered out along the way).
Finally, compose the message you'd like to send to external users (vendors, customers, students, etc.). For example, a reply message to senders outside your organization may provide an alternative contact name and phone number to handle email inquiries while you are away, or you may want to let senders know whether you will be checking email periodically or not at all during your time out of the office. You can copy the internal message and paste it here or have two different messages, each appropriate for the audience.

9. Click **Save** to save your settings to the Exchange Server.

Even after your automated reply period is over, the Exchange Server retains your automated replies on the server. They will be available via OWA or after you migrate over to Outlook. The next time you need to set your automated replies, you need only change the dates and tweak the message a little bit.

**NOTE:** If you need to stop automated replies prematurely (early return from vacation, etc.), you can simply change the radio option button back to “**Don’t send automatic replies**” at the top of the settings window. This turns them off immediately.

**Configuring Signatures**

Microsoft Exchange Server allows for three primary types of clients: the full client (Outlook), the mobile client (Android, iPhone, Windows Phone), and the web client (OWA). In each of these clients, you can configure a custom signature. The signature is automatically appended to your email messages every time you compose a new message or reply to a message.
NOTE: If you configure an auto signature for OWA, it will not automatically transfer to the Outlook client. You'll need to set up the Outlook auto signature separately.

To create or change your email signature in OWA

1. Navigate to the Mail tab of the Settings pane in OWA options.
2. Under the E-Mail Signature section, check the box titled "Automatically include my signature on messages I send." This turns on the auto signature for every message you initiate or reply to. Unlike the full Outlook client, you cannot configure different signatures for new messages versus replies.
   
   You can edit your signature in the formatted text box provided. OWA supports font formatting for auto signatures, but does not support inserting graphics or photos.
3. Click Save

TIP: Some people maintain different signatures for different devices. In addition to contact information, these device-specific signatures can be used to notify recipients of your current status. For example, the fact that you're responding from OWA might send the message that you're not at your regular computer.

Email rules in OWA
Inbox rules are another feature in Exchange Server that helps users with mailbox management. Rules run on either the Exchange Server or the Outlook full client. Server-side rules are processed when the email message first hits the system. Client side rules (full Outlook) are only processed when the Outlook client is opened on a workstation. Typically, client side rules rely on features specific to the workstation. For example, you can create a rule to play a specific ring tone when mail comes in from your manager. Client side rules are out of scope for this training.

**About Rules**

All rules created in Outlook Web App are server side rules. As such, they will work with both the OWA client and full Outlook client. Rules consist of three components: triggers, actions and exceptions. A trigger is an event, such as:

- You receive mail from a certain person
- You receive mail that was sent to a distribution list that you subscribe to
- You receive flagged message (sensitivity, priority)
- You receive a message of a certain size

Exchange evaluates every message that enters your mailbox to determine whether it matches any of the triggers defined by any of your rules. It processes the rules sequentially, meaning that the first rule found to match will be processed. By default, only the first matching rule is processed against the message, but you can change that. This is generally not recommended unless you're dealing with extraordinary circumstances. Once the rule's trigger is recognized, your rule might take any of the following actions:

- Move it to an alternate folder in your mailbox
- Delete it
- Forward it to another person or another email account (such as your hotmail or gmail account)
- Reply to it (this often requires a client side rule and it out of scope for this training)

Finally, each rule allows for exceptions. If a message matches a trigger, it is then evaluated for whether it matches an exception. If it also matches the exception, the action is not taken and the message will continue being processed by additional rules. So it's possible for your message to match two different rules, but because it is an exception to rule 1, it's processed instead by rule 3. Consider the following scenario.
Figure 28 - Rule processing example

The message from your manager is received in the mailbox and undergoes rule processing. It matches the first rule, but your manager has sent it to everyone on your team, not just you. As such, the message is moved to a folder under your inbox that is reserved for manager communications. A second message from your manager is sent with specific instructions for you. It is sent only to you. The second message will be processed by the first rule, but because it also matches the exception, the first rule's action will not be taken, and it will be processed by the second rule. The second message will stay in your inbox and will automatically have a "flag for follow-up" applied to it.

TIP: The most common mistake people make is confusing the sender and recipient of a message sent to a distribution list. One person (the sender) sends a message to many recipients (members of the distribution list). Many people configure the rule to match messages sent "from a distribution list" instead of messages sent "to a distribution list." The result of this misconfiguration is that all messages from any member of the DL sent to you (even those not sent to the distribution list) get processed by the rule. What most people are trying to do is store conversations sent to the distribution list in a specified folder so they can review at their leisure.

Creating a rule to redirect inbound email

1. To create a new rule in OWA, select the Create an Inbox Rule command from the Options menu in the upper left side of the screen. The example below will illustrate how to set up mailbox forwarding to an external email account:
2. From the Inbox Rules toolbar, select the **New** dropdown menu and click on **Create a new rule for arriving messages.**

![Image of Inbox Rules](image)

*Figure 29 - Creating a new rule*

3. A new window will open with two drop down boxes, one for the trigger and one for the action.

![Image of New Inbox Rule](image)

*Figure 30 - Rule triggers and actions*

4. In the **When the message arrives, and:** drop down box, choose [Apply to all messages]
5. In the **Do the following:** drop down box, select **Redirect the message to…**
   a. This will bring up an address picker window where you can search for names in the global address list, or simply type the email address where you'd like messages redirected to.
b. Enter the full email address of where you’d like the message redirected (note that this keeps a copy of the message in both locations requiring you to clean out your Exchange inbox from time to time).

6. Click on the More Options... button. It will expand the window with buttons for adding exceptions and a checkbox to Stop processing more rules. Make sure it is checked.

![Image of rule exceptions]

7. You should also type a descriptive name for the rule in the Name of rule text box.
8. Click Save to save your changes on the server. At this point all new messages will be subject to this rule.

**Configuring Spell Check**

OWA provides its own spell-checking module that can be configured in addition to any spell-checking capabilities built into your browser client. The spell checking feature in OWA is not real time; you can only check messages just before they are sent. Options are also fairly limited. You can ignore words in all upper case (presumably acronyms) or words with numbers in them.

To change your spell checking settings, go to Options --> See All Options... and select the Settings pane on the left side. Choose the Spelling tab. To turn spell checking on or off, simply select or unselect the checkbox titled Always check spelling before sending. Also ensure that your dictionary is set to English (United States).
Remote Smart Phone Wipe

*SPEAKER NOTES:* This is a unit that is best walked through on the interface to show users how to remotely wipe their phone. Please be sure to tell them that this is not reversible and they will have to start over to re-sync their phone. When demonstrating, it’s not necessary to wipe your cell phone in the process.

If you have a smart phone connected to the Exchange environment, your phone will automatically download the policies and minimum security settings defined by the University of Arizona. You can see which phone devices are registered with the Exchange environment by going to Options → See All Options... and select the Phone pane on the left side. Choose the Mobile Phones tab.

Your device type, partial phone number, last sync time and current status will all be displayed for each device you’ve registered. You can see additional information for any device by selecting the device and clicking on the Detail button on the toolbar. You can also delete relationships with the server by choosing the delete button [X] with the appropriate device selected.
In the event that you lose your device, you can log onto OWA and remotely wipe the phone. Select the device, and click the **Wipe Device** button. The next time your mobile phone connects, it will receive the command to wipe its memory. Information stored on SD cards will not be affected.

**Text Message Notifications**

*SPEAKER NOTES: This is also a challenging unit to demonstrate, other than configuring a rule where certain messages sent to you automatically trigger an SMS forwarding. For most users, these features aren't particularly compelling, as they’re already using smart devices that have full calendaring and email functionality built in.*

If you don’t have a smart phone but do have a texting plan, you can configure OWA to automatically notify you for appointment/meeting reminders or when you receive email that meets a certain set of conditions. Before you can set up these rules, you'll need to register your mobile phone number with OWA. To register a device, click **Options --> See All Options**. Choose the **Settings** pane and select the **Text Messaging** tab. On the options screen, choose the **Turn On Notifications** button. A wizard will walk you through the process.

1. Enter your locality (United States) and mobile operator.

![Figure 34 - Text message notification 1 of 3](image)

2. If you don’t see your mobile operator in the drop down, it is because that carrier currently doesn't support this feature.
3. On the second tab, you'll enter your 10-digit cell phone number and click Next.

![Text Messaging](image1.png)

Figure 35 - Text message notification 2 of 3

4. At this point, a text message with a six digit code will be sent to your cell phone. The next screen will ask you to enter the code to validate the correct number is registered.

![Text Messaging](image2.png)

Figure 36 - Text message notification 3 of 3

5. If the number is good, click finish. You'll receive a second text message to your phone notifying you that it was successful.

You are now ready to establish cell phone alerts. For purposes of this training, we'll cover the two most common alert configurations. The first one is the inbox alert. This is intended to notify you, via text messaging, that you have received email matching a certain set of conditions. For example, you might want to be notified whenever you receive email from your manager. Once notifications are set up, each
time you receive a message that matches the conditions, it will be forwarded to your cell phone as a text message.

The message will appear to come from your email address. In the body of the text message, however, will be the original sender's name, the subject, and the first few lines of the original message's body. While every cell phone looks different, a text message might look like the following:

![Text message example](image)

**Figure 37 - SMS Notification of Email**

To configure this:

1. Click the link titled "Set up e-mail notifications using an Inbox rule..." and it will open the dialog box pictured.

![New Inbox Rule dialog box](image)

**Figure 38 - Text message notification for email example**

2. From the "When the message arrives, and:" drop down box, select **It was received from...**
3. The address book picker (see Figure 17 on page 18 for visual) comes up and you can type, search for or select the name from the university address book or your contacts list. You can select as many recipients as you like.
4. Under the "Do the following" drop down, choose **Send a text message to** and your registered cell phone should automatically appear.
5. Click **Save** to save your settings. You will now receive a text message to your cell phone each time your manager emails you.

TIP: Be cautious when configuring text messaging rules. Your cell phone company may charge you for each message you receive and if your rules aren’t configured carefully, you might find the constant stream of SMS notifications to be more of a nuisance than a benefit.

The other common SMS notification that people like to set up is for calendar reminders, updates and agendas. By clicking the **Set up calendar notifications...** link from the **Text Messaging** tab, OWA will allow you to configure three different kinds of notifications that pertain to your daily schedule. To turn any or all of the notifications on, check the appropriate checkbox and click **Save**.

![Figure 39 - Calendar text messaging options](image)

The first option allows you to receive notifications whenever your calendar is updated. Your calendar is automatically updated whenever you receive a new meeting request\(^4\) or you add an appointment. The "notifications for meeting reminders" can be checked if you’d like to receive a text message just before your next appointment. By default, meeting reminders fire 15 minutes before an appointment, but this is configurable on a per-appointment basis.

Finally, you can configure OWA to send you, via text messages, a copy of your daily calendar agenda. Simply choose the time you want OWA to send the messages and your entire day’s appointments and meetings will be forwarded.

---

**NOTE:** These text-messaging for calendar settings can also be configured under the **Calendar** tab of the **Settings** pane.

---

\(^4\) Your calendar is updated even if you do not accept the meeting. By default, new meeting requests are stored on the calendar as tentative until you accept or decline them.